English 110 Faculty Development Workshop

Teaching Revising and Editing Strategies
April 11, 2007

Goals
- To examine how we can help students distinguish between revising and editing.
- To share ideas for teaching revising and editing strategies.
- To identify revising and editing strategies that appeal to a variety of learning styles.
- To discuss ways to facilitate student practice of a variety of writing process strategies.
- To highlight writing process resources in recommended rhetoric textbooks.

English 110 Objective
All sections of College Writing aim to develop a more sophisticated writing process—including invention, peer responding, revising, and editing—that results in a clear, effective, well edited public piece.

Instructional Goals based on Assessment Results
In both 2005 and 2006, students reported engaging in one or two strategies for revising and editing but not a variety of strategies. By helping them identify multiple strategies and build a repertoire from which they can choose, we help students prepare to manage their future writing projects. As a result, one of our 2006-2007 instructional goals is to present a variety of invention, drafting, revising, and editing strategies in our classes.

Our Fall 2006 assessment results suggest we are making progress towards this instructional goal by offering more variety in invention and drafting strategies. We can continue this trend by planning to incorporate more diversity throughout the writing process (including in revising and editing stages).

Helping Students Distinguish Between Revising and Editing

1. Brainstorm & categorize writing process strategies
   - Brainstorm process activities as a class. Students often bring different experiences to English 110, but they might not be aware of the multitude of strategies they can try at each stage of the writing process. Brainstorming capitalizes on their expertise and introduces them to a range of options. (See Ashley Holmes’ example)
   - Brainstorm only revising and editing practices, categorizing items on the board as students offer additions.

2. Discuss rhetoric textbook and handbook descriptions of revising and editing. Compare how different texts discuss each process stage.
• For instance, *The Brief Thomson Handbook* describes the writing process as “fluid movement among different kinds of activities” and visually highlights the often non-linear process (10). Yet the handbook also clearly differentiates between revising and editing using descriptive terms for activities that fall under each stage (see p. 11).

• Like *The Brief Thomson Handbook, Meeting of Minds* emphasizes revising and editing to meet readers’ needs. The rhetoric textbook offers chapters on both of these stages of the writing process (see Chapters 11 and 12).

• *Work in Progress* encourages students to “find your own best way” (40). The author notes that different strategies work better for different writers; she suggests that students take the time to try a variety of process writing strategies until they find the best-fit options.

3. Making this discussion explicit helps students throughout the writing process.

• Students will be better prepared to identify peer feedback prompts asking about content and structure, as opposed to prompts asking about word choice, grammar, and punctuation.

• Students will be prepped to make more substantial revisions if they understand the categories of changes classified as revisions (as opposed to edits).

Teaching Revising and Editing Strategies

1. Teaching Revising Strategies

• Introduce self-evaluation strategies. Teach students how to translate assignment guidelines and evaluation criteria into questions they can pose to themselves and their draft readers.
  o *Meeting of Minds* describes self-evaluation, peer evaluation, and instructor evaluation. The authors offer tips for self-evaluation, including reading out loud and taking a break between drafting and revising. (See p. 332 for a complete description.)
  o *The Brief Thomson Handbook* offers a project checklist that includes reflective questions about the writing process/product, evaluative questions about the content and support, and descriptive questions about voice and tone (see p. 31). Additional checklists prompt revising for context, with questions about audience, purpose, and *kairos* (see p. 32), and revising for kinds of evidence (see p. 34).
  o *Work in Progress* lists questions on focus, content, and organization that students can use for self-evaluation (see pp. 309-310).

• Introduce strategies for revising with technology. Although students are used to working with many forms of technology, they might not have received instruction in strategies for writing with technology. Many recent rhetoric textbooks and some
handbooks incorporate writing with technology into their discussions of the writing process.

- *The Brief Thomson Handbook* includes guidelines for commenting on a document in a Word Processor and for tracking changes in a document (see pp. 38 & 41-42). These tools can help writers document their own revisions, assist peers who are offering feedback, and allow instructors to anchor their comments to specific portions of students’ texts.
- *Work in Progress* encourages critical use of technology. The author identifies word processing functions that can aid revision but also prompts students to print drafts to aid global revision.
- Most of the recommended texts include reminders to create backup copies of work, to save often, and to print hard copies periodically.

- Go low-tech: Take scissors and tape into the class. Direct students to cut their printed papers into smaller chunks and to rearrange them until they find the order that makes the most sense to them. Twist: Have students give the chunks to a classmate to arrange.

- Blind revision: Ask students to set aside their papers and to rewrite the introduction or conclusion based on their memory of the text and the main points they want to make. Then ask students to compare the new drafts to their papers and to plan revisions accordingly.

- Require students to write a revision plan. This activity could be a five-minute write in class or a more formal out-of-class assignment. Prompt students to consider how they will respond to feedback, what timeline they will follow, how they will revise to better address audience needs, etc. *Meeting of Minds* includes an example (see p. 341).

- Other ideas?

2. Teaching Editing Strategies

- Integrate instruction on using handbooks. Students are more likely to turn to these resources if they know how to use them.
  - Introduce notable features of the handbook during the first week of class. Many handbooks include a brief introduction with tips for using the text.
  - Prepare a scavenger hunt activity, prompting students to answer writing questions by using the handbook. For many current handbooks, these questions could range from managing the writing process and writing with technology to making stylistic choices and integrating visuals.
  - In one-on-one or small group conferences, have students attempt to find answers to style and editing questions and citation questions using a handbook. Offer strategies for using navigational features (i.e., tabs, indices, table of contents).
• Teach editing in context. Select one or two stylistic features or editing concerns to comment on and offer strategies for revisions or future writing. Research suggests that grammar instruction is most effective when offered in the context of students’ own writing and prioritized to focus on one or two topics per paper.

• Allow last-minute edits before students submit. Do not penalize for these final edits. Twist: Encourage students to have a peer suggest edits before students submit their papers. Give students time to consider the edits, ask questions, and make changes before collecting papers.

• Other ideas?

Textbook Resources for Teaching Writing Process Strategies

1. *Meeting of Minds* devotes two chapters to revising and editing, in addition to providing integrated strategies for revising that are tailored to each chapter. The revising chapter includes a variety of activities students can try and explains why they are helpful for some writers. The strategies are categorized as “revising for compelling ideas,” “revising for unity and form,” and “revising for voice and tone” (Chapter 11).

2. The “Guide to…” feature in several chapters of *Everything’s an Argument* include questions for response; these tailored questions could be used for self-assessment or peer review to prompt revision and editing.

3. *Work in Progress* includes chapters on “Strategies for Managing the Revision Process” and “Strategies for Revising Structure and Style.” A chapter on “Understanding the Writing Process” also offers tips for identifying the writer’s own process and for using technology.

4. *Classical Techniques and Contemporary Arguments* describes revision as “a natural and welcome part of the writing process” (146). The text introduces rhetorical terms to talk about writing and uses those terms throughout. The authors also integrate peer revision questions that support student revision and editing.

5. Both versions of *The Thomson Handbook* include strategies for managing the writing process, conducting research, citing sources, presenting information, writing with technology, and editing for style.
Next workshop:
  - Summer Retreat, August 2007
  - Please bring a draft of your Fall 2007 syllabus for English 110.

Additional updates:
  - On Wednesday, April 25th, Students will receive the first email invitation to participate in this semester’s English 110 assessment. Students who have not completed the assessment will receive follow-up emails on Monday, April 30th, Thursday, May 3rd, Monday, May 7th, and Friday, May 11th. Please encourage your students to complete the survey, and if you teach in a computer lab, please consider giving them time in class to do so.
  - English 110 faculty will receive an invitation to participate in a faculty version of the assessment on the same schedule. Please take a few moments to complete the assessment. All responses are anonymous.
  - Watch for an additional email invitation to offer feedback on the English 110 faculty development offered this year. All responses are anonymous. I value your comments and will consider them as I prepare next year’s workshops. Thank you for your participation!
Using MS Word Reviewing Tools for Peer Review and Assessment

The Reviewing Tools in MS Word help facilitate a paperless classroom, but they also help students and instructors give helpful feedback by anchoring comments to the text.

Accessing the Tool Bar
To view the Reviewing Tool Bar, open the View menu at the top of the screen. Select Toolbars and then Reviewing. If you see a checkmark next to Reviewing, the toolbar already is accessible. Look for the tools selected below.

Using the Insert Comment Command
By selecting text with my cursor and then clicking on the Insert Comment icon (the sticky note), I can anchor a comment to a specific section of the paper. This feature allows me to point to specific examples in the text. For example, if a section in a paragraph seems unrelated to the rest of the paragraph, I can highlight the sentences and insert a comment that indicates that I am not sure how the writer is connecting the idea to the other ideas in the paragraph. If a student has a great example or an especially well-written sentence, I also can draw attention to those features.

To delete a comment, right click on the comment bubble and select “Delete Comment.” You also can use the Reject Changes/Delete Comment icon (the pencil and X combination) on the Reviewing toolbar to delete comments or the Accept Changes icon (the pencil and checkmark combination) to accept a comment or changes.

Using the Track Changes Command
Track Changes lets you type in students’ documents, but it clearly identifies your additions and gives students the option of deleting your typed comments. After clicking the Track Changes icon, all my typing is identified by colored text and an underline. I want students to retain ownership/authorship of their texts, so I don’t make changes to what they’ve written, but I occasionally use the feature to give them some overall comments at the end of the document, especially if I’m not using a rubric. Click the icon again to turn off the tool.

I also encourage students to use the Track Changes feature when they are working on collaborative projects. They can email each other the latest version of their documents and track the changes and suggestions that group members are making. Under Tools → Options → User Information, they can enter their own names and initials so that group members can identify the writer of each set of comments. To accept or reject a Track Changes addition or deletion, right click on the change (or the related comment bubble) and select the appropriate function (accept or reject).
Student Reactions to These Tools
One of my current students sent the following unsolicited note: “Just wanted to say how impressed I was with the feedback both in content and the way it was left (highlighting and bubbles).” His comment echoes other student feedback that I’ve received; students appreciate the accessible comments that are anchored to the text, since these comments help them identify specific strengths and weaknesses as they work to become better writers.

Viewing Comments
Make sure the drop down box at the left end of the Reviewing toolbar displays “Final Showing Markup” if you want to view comments and tracked changes. If you change this selection to “Final,” the comments are hidden from view.

Similarly, if you want to print the comments, select “Document Showing Markup” from the “Print What” drop-down menu in the Print window (File → Print → Print What). You also can print only the comments (“List of Markup”) or the document without comments (“Document”).
## Writing Process Strategies (Ashley Holmes)

**Derived from The Longman Writer's Companion pages 10-30, A Meeting of Minds pages 50-4, and English 110 students**

### Planning

**Generating ideas:**
- Freewriting and focused freewriting
- Listing
- Strategic Questions (What?, Why?, Why Not?)

**Structured planning:**
- Clustering
- Tree Diagramming
- Time Sequences (for chronological projects)
- Problem-Solution Grid
- Outline (phrases or sentences)
- Sketching connections with lines, shapes, and diagrams

**Extra preparations:**
- Talking to other people to get reactions to your ideas
- Arguing against your idea to test it
- Gathering information from your memory
- Conducting formal or informal research
- Try the writing center. Remember consultants can help at ANY stage of the writing process, including planning after you’ve received an assignment.

### Understanding Purpose and Audience

**Analyzing purpose:**
- Define the focus of your task or assignment (define a topic)
- Ask: What question am I answering?
- Define the purpose of your task
- Look for “action statements” in your assignment sheet. Circle action verbs such as “analyze,” “describe,” “explain,” “compare,” etc.
- Rough out a purpose structure (order your thoughts in some way)

**Considering your readers/audience:**
- Ask: “Who are my readers?” and “What will they be expecting?”
- How do you want your audience to react? What do you want them to do, feel, think, understand, etc?
- Analyze audience considering: Size and familiarity, community, knowledge, social context, intellectual disposition, conditions of reading, power, etc.
- Adapt your writing style, language choices, citation practices, etc. to meet the needs and expectations of your audience
- When adapting: select the genre readers expect, shape your content to the context, adjust your structure to the situation, anticipate possible responses of readers

### Drafting

- Can begin by making a series of phrases
- Use your notes from planning as you begin drafting (ex: follow an outline).
- Group your ideas based on similarity and/or placement in paper (Introduction, Body, Conclusion, etc.).
- Shape ideas, make sure they are clear to you
- Write casually (“rip out” a “crappy” first draft to get you started).
- Don’t worry about word or page count, grammar, or spelling at this point
- Try to stay focused on your topic/purpose, and consider whether you’re achieving your goals in the assignment.
- Write about your writing (reflect on how things are going).
- Try semi-drafting (making notes in your draft to elaborate on when revising).
- Start drafting as you conduct research.
- Draft out of order (i.e. start with the body paragraphs, and then go back to your introduction).
- Draft in a quiet place without distractions (the library, when your roommate’s out, etc.)
- **TURN OFF INSTANT MESSENGER!**
- Attempt healthy drafting rituals (exercise before, during a break, or after; eat healthy snacks; don’t draft at 2:00 a.m., etc.)

<table>
<thead>
<tr>
<th><strong>Editing</strong></th>
<th><strong>Revising</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Editing involves local or sentence/word level issues.</td>
<td>• Revising involves global or structure/content level issues.</td>
</tr>
<tr>
<td>• Editing is when you look at grammar, spelling, word choice, etc.</td>
<td>• Revising may involve redrafting, adding more, cutting items, etc.</td>
</tr>
</tbody>
</table>

**In both editing and revising:**
- Consider audience, purpose, and context: The “best” style of writing depends on the audience’s expectations.
- Try the writing center (in the library or online center).

**Editing on your own or collaboratively:**
- Proofread slowly
- Start at the end of your paper and focus on one sentence at a time.
- Focus on one issue at a time (ex: look at all commas, then look for spelling only, etc.)

**Editing on your own:**
- Take a break between drafting and editing/revising.
- Take small breaks throughout the editing process
- Know your typical errors
- Read comments on past papers and try not to repeat them again.

**Editing on the computer:**
- Spelling and grammar checks won’t catch everything!
- Try using the “Insert” → “Comment” feature in MS Word to leave notes for yourself

**Major Revisions (make the draft as a whole more effective):**
- Redraft workable material
- Reorganize paragraphs or sections
- Add new material
- Connect similar materials (combine paragraphs)
- Delete unnecessary material
- Substitute or transform ways of expressing ideas for clarity, vividness, emphasis, or interest.

**Minor Revisions (small changes to refine and polish passages):**
- Revise for sense
- Revise for style
- Revise for economy (conciseness). Use Bell’s telegraph metaphor.
- If you had to cut 10 words from every page, which would you cut?

**Add transitions throughout**

**Revising collaboratively:**
- Respond honestly, giving specific feedback.
- Offer a balance of positive feedback, as well as suggestions for improvement.
- Be respectful.
- Turn to your readers for their responses.